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Leaders in Financial Modeling Since 2002

« We believe that spreadsheet-based financial models are the most important decision-
making tools in modern finance

 We have developed a framework and discipline for model design, structure and
development that leads to best-in-class, user-friendly financial models

» We help finance professionals use this framework to turn their models into powerful
communication tools that lead to better, more effective decisions
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https://selfstudy.marqueegroup.ca/
https://academy.trainingthestreet.com/

Training The Street === TRAINING

Acquired The Marquee Group in April 2023

Training The Street (“TTS”) is a leading professional development training provider
headquartered in New York

Paired with Marquee’s world-class instructor team and content, the TTS team adds a
wealth of learning assets, trainer capabilities and creates a unique global training provider
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Creating a Merger Model




Rationale for Merger Models

 When a buyer or seller contemplates an acquisition or divestiture, a pro-forma analysis
is prepared to evaluate the potential impact on:

— The income statement
— The balance sheet
— Cash flow and creditworthiness
* Pro-forma analysis is used to determine:
- How much to pay
- Optimal form of consideration (cash, stock, combination)
— Impact on ownership
- Synergies required
« Used by both buyers and sellers
- Buyers evaluate highest price they can afford to pay
- Buyers evaluate how much other competitive bidders can afford to pay
- Sellers evaluate how much potential buyers can afford to pay

THE
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What is a Merger Model?

* Merger models come in two classes:
— The “mini” merger model
— The “full blown” merger model
» The difference between the mini and full merger models:

— The mini merger model would rely on the latest financial statements and EPS and/or CFPS
forecasts

— The full merger model would combine fully integrated three-to-five year projections for both the
target and purchaser

» The purpose of this section is to discuss the construction and financial implications of a
mini merger model

THE
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Inputs Required

» The following inputs are required to create a mini merger model for two public
companies:

- EPS or CFPS forecasts (preferably at least two years) for both the target and acquiror
— Current share price for both companies

— Current fully diluted shares outstanding for both companies

— Assumed purchase premium or purchase price per share of the target company

- Transaction fees

- Form of consideration

— Interest rate on new debt that may be issued as consideration

- Appropriate tax rate (often the acquiror’s tax rate) for the new entity

- Assumed synergies that will be realized from the transaction

- The most recent balance sheet for both the target and acquiror

« Other inputs can also be included to make the model more detailed and/or flexible

THE
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M&A Considerations




Rationale for M&A Activity

« Boards and management teams of companies cite various reasons for engaging in
merger and acquisition (M&A) activity, including:

BUYERS SELLERS

Shareholder value creation
Strategic fit
Revenue growth

Synergies (economies of scale and scope, costs
savings etc.)

Earnings and/or cash flow accretion
Undervalued target

Improved competitive positioning
Revenue diversification

Access to talented management

Use of excess cash

Shareholder value creation / maximization
Pressure from activist shareholders
Exit of a controlling shareholder

Inability to compete successfully as a stand-
alone entity

If assets or a division being divested:
- Lack of strategic fit

- Raise cash for redeployment or debt
reduction

« Any M&A deal should be evaluated carefully on both quantitative and qualitative
grounds

THE
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The M&A Process

* MZ&A deals can occur following:
- A private, “friendly” negotiated process
— An auction process (can be limited or far-reaching)
— A hostile approach

« Each M&A transaction can vary in terms of the steps in the process and the time to
complete each step

» Atypical “sell-side” process will involve the following general steps:

Preparation &
Buyer
Identification

Contact Due Negotiation &

Potential Buyers Diligence Closing

» Financial analysis will play an important role throughout any M&A process

THE
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Assessing an M&A Deal

 Management and boards of companies, along with their advisors, use a number of
financial tools to assess the value and attractiveness of an M&A deal:

— Financial projections

- Discounted cash flow analysis

- Assessment of synergy potential

- Trading comparables

— Transaction comparables

— Accretion / dilution analysis

— Leveraged buy-out analysis

— Analysis of premiums paid in precedent M&A deals
— Break-up analysis

- Competitors’ ability-to-pay

- Estimated cost basis in the stock of the selling shareholders
— Credit impact analysis (short and long-term)

* In a “live deal” situation, parties will examine most or all of the above

THE
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Forms of Consideration

» There are typically two types of consideration that one company can use to acquire
another company:

- Cash
- Common stock of the acquiror

« Acquirors have a number of options in sourcing acquisition currency:

CASH COMMON STOCK
« Cash on acquiror’s balance * Issue new shares directly to
sheet target company or its

shareholders
e (Cash on seller’s balance sheet

» Sell equity in the market and
use cash proceeds for the
acquisition

* Raise / borrow new debt

* In certain circumstances, other securities of the acquiror may be used as consideration,
including debt (i.e., issued to a selling company or its shareholders) or preferred stock

* In many M&A deals, a combination of forms of consideration is used

THE
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Cash vs. Stock as Consideration

« Many factors must be considered in deciding the form and mix of consideration in an
acquisition

— The buyer and seller may have different preferences for cash vs. stock

BUYER’S PERSPECTIVE SELLER’S PERSPECTIVE

» Using debt is generally preferable given » Sellers like receiving cash because it is the most
its lower cost and tax advantage relative to liquid form of consideration and its value is
equity certain

* However, the amount of debt used can be limited  « However, the receipt of cash will trigger a tax
by: event (gain or loss) upon the sale

- Aversion to excessive debt » A seller may prefer to receive stock of the

acquiror if the seller is confident in the prospects

- Limitations imposed by lenders of the combined company

» Using equity may be viewed positively especially

. 7 o g * In addition, receiving shares as consideration is
if the acquiror’s stock is “overvalued

often treated as a tax-free rollover, which allows

- However, issuing equity is costly and dilutes the for the deferral of any tax impact until the
ownership of existing shareholders ultimate sale of the shares
THE
MAR%JEE 14 © 2006 The Marquee Group Inc.
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Analysis in an All-Stock Deal

* In a transaction involving the exchange of seller shares for acquiror shares, certain
other analyses will typically be performed:
- Exchange ratio analysis: The exchange ratio is the number of shares of the acquiror that will be
given as consideration for each share of the seller:
Exchange ratio = Target Acquisition Price per Share / Acquiror Stock Price

Typically, exchange ratios over a long historical period will be examined to assess the relative
attractiveness of a deal

— Contribution analysis: Contribution analysis involves examining various financial metrics of the
buyer and seller (i.e., Revenues, EBITDA, Net Income) to determine their relative weight and
what that implies for an exchange ratio. It is important to note that unlevered metrics (Revenues,
EBITDA) need to be adjusted for the companies’ respective capital structures before an exchange
ratio can be implied

* All-stock deals can be structured with:

- Fixed exchange ratio: the number of acquiror shares per target share is fixed, so the value
received by selling shareholders can fluctuate

- Floating exchange ratio: the number of acquiror shares per target share floats, so as to ensure a
fixed value per share for the seller

— Caps and collars specifying minimum and maximum thresholds

THE
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Purchase of Shares vs. Assets

* An acquisition can be structured as a purchase of the selling company’s shares or its
individual assets

— Each structure has important implications for the buyer and seller

ASSETS SHARES
Liability *  Buyer does not assume any related *  Buyer assumes all liabilities of the acquired
Considerations liabilities (direct or contingent) entity
Tax Considerations
Buyer tax basis *  Buyer can “step-up” the value of assets e Buyer inherits existing tax basis in acquired
for tax purposes and take incremental assets — no additional depreciation for tax
depreciation expense purposes
Seller tax basis * Seller’s basis in assets tends to be lower *  Given that shareholders buy and sell
than selling shareholders’ basis in shares, regularly (especially in public companies),
which may result in incremental tax the average tax basis in shares can be
+  Also, selling assets may result in another relatively high
layer of tax upon liquidation
Tax losses «  Buyer will not acquire any tax losses of the  «  Buyer acquires all of the tax losses of the
acquired entity acquired entity

« Given the above, in most circumstances buyers prefer to buy assets and sellers prefer
to sell shares

THE
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Accounting Issues

» Prior to 2002, there were two methods of accounting for the purchase of a controlling
stake in a company:

— Purchase Method
— Pooling Method
« As of 2002, only the Purchase Method is available

« The purchase method of accounting treats an acquisition of the shares of a company
essentially the same as the purchase of the assets and assumption of the liabilities of
that company

« The purchase price paid for the acquired company must be allocated to the assets and
liabilities assumed up to their fair market value

- The incremental value over book, if any, allocated to the assets of the subsidiary will be
depreciated over the remaining life of assets

» The excess of the purchase price over the fair market value of the net assets is referred
to as “goodwill”

— As of 2002, goodwill is no longer amortized annually

THE
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Purchase Price Allocation

» In assessing the impact of an acquisition on the acquiror’s balance sheet, first compare
the purchase price of the target’s equity to the book value of target’s equity

— The difference can be considered as “Excess Purchase Price”
* The target’s assets and liabilities will be written to "fair value”

- The difference between the Excess Purchase Price and any change in the value of net assets
from fair value adjustments will be allocated to Goodwiill

» Below is an example of purchase price allocation:

(in $ millions) . . . .
Purchase Price of Target Equity $1,345 — Fairvalue adjustments Yw”. t.)e applied to

: the relevant asset and liability accounts
Less: Book Value of Target Equity $587 on the acquiror’s closing balance sheet
Excess Purchase Price $758 9 g

— The remaining Excess Purchase Price

Less: Net Fair Value Adjustment $208 will be allocated to the acquiror’s
Goodwill $550 Goodwill account

THE
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Deferred Tax Liabilities in M&A

« When an acquisition is structured as the purchase of a company’s equity:

- For Accounting purposes, the acquired assets and liabilities can be written up (or down) to fair
market value

- For Tax purposes, the acquired assets are generally NOT written up to fair market value

« If any assets written up for accounting purpose are long-lived and therefore need to be
depreciated or amortized over time:

— This creates a immediate imbalance between the tax books and the accounting books

- All else being equal, the company will now have excess accounting D&A over tax D&A, which will
make accounting pre-tax income lower than government pre-tax income

- Over the life of the written up asset, the company will therefore report lower income tax expense
on its income statement than it actually pays to the government

- The cumulative amount of the difference between income tax expense reported and tax
paid is reflected at closing on the acquiror’s balance sheet as a Deferred Tax Liability

THE
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Deferred Tax Liabilities in M&A (Cont’d)

» The Deferred Tax Liability (or “DTL”) recognized at closing will be reduced over the life
of the asset as the company’s reported tax expense is less each period than the
amount paid to the government

- The DTL is needed to balance the balance sheet since Retained Earnings will go down less than
Cash each period due to the tax impact

« The table below shows an example of the effect on the company financials over time:

Year1 Year2 Year3 Year4d Year5 Assumptions

INCOME STATEMENT Asset Write-Up $100

EBITDA $100 $100 $100 $100 $100 Deferred Tax Liability $30

Less: Incremental D&A $20 $20 $20 $20 $20 Tax Rate 30%

EBT $80 $80 $80 $80 $80 Amortization Period 5 years
Annual D&A $20

Current Tax $30 $30 $30 $30 $30

Deferred Tax (%6) ($6) ($6) ($6) ($6)

Total Tax $24 $24 $24 $24 $24

BALANCE SHEET At Closing:

Written Up Assets $100 $80 $60 $40 $20 $0

Deferred Income Tax Liability $30 $24 $18 $12 $6 $0

» In share purchases, accountants will sometimes allocate fair value to previously
unrecognized finite-life intangible assets (i.e., customer lists)

— These new assets effectively reduce the amount of goodwill recognized, but the offsetting
Deferred Tax Liability increases goodwiill

THE
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Income Statement Impact

* The Income Statement impact of a merger model is referred to as the accretion /
dilution analysis

» Accretion / dilution is an important metric that management, boards, investors and
research analysts focus on in the context of an M&A deal

- Accretion / dilution simply means, “Is the pro-forma EPS of the merged entity greater
than the stand-alone EPS of the acquiror”

Forecast EPS of Company A in 2021 on a stand-alone basis: $X/ share

Pro-forma EPS of the merged company in 2021: $Y / share

If $Y > $X, the deal is said to be Accretive to earnings
- If $Y < $X, the deal is said to be Dilutive to earnings

» Accretion / dilution can also be measured on other metrics such as Cash Flow per
Share

» Itis also common to calculate the amount of pre-tax synergies needed to break-even

THE
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Income Statement Impact (Cont’'d)

« The following adjustments need to be made to calculate the pro-forma Income Statement:
1. Synergies
- Link synergies to the appropriate line: Revenue, EBITDA, Capex, etc.
- Calculate the tax impact of synergies
2. Depreciation & Amortization
- Calculate the incremental annual D&A expense associated with the fair value “write-up” of assets (if any)
— Calculate the tax impact related to incremental D&A
3. Interest Expense
- Include incremental interest on new debt (if applicable)
- Eliminate cost of refinanced debt (if applicable)
- Eliminate interest income associated with cash balances used to fund the acquisition (if applicable)
- Include the interest income associated with the cash received from the exercise of options
- Calculate the tax impact of debt financing items
4. Common Equity
— Link number of new acquiror shares issued
- New shares issued = equity component of financing / issue price

- Take into account the impact of any dilutive securities of the target (i.e., convertible debt or preferred
stock)

THE
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Synergies

« Synergies are a pivotal driver in M&A transactions

« When two companies combine and can achieve higher revenues or lower costs than
they could on their own, by definition synergies have been achieved

- Cost synergies: Merged companies can save costs by eliminating duplicative / unneeded
manufacturing capacity or employees. Another example is using larger scale to improve
purchasing power with suppliers. Cost synergies are usually the easiest to identify and quantify

- Revenue synergies: Companies can increase combined revenues by cross-selling across their
respective customer bases or by developing new products. In some cases, revenue synergies will
result simply from increased scale and the resulting pricing power with customers

« Many constituents will scrutinize synergies, especially in larger deals

- Governments and unions may be concerned with job losses, while regulatory bodies and
consumer advocacy groups will closely examine whether a deal yields too much market share /
pricing power

« Often, material costs will need to be incurred to generate synergies (i.e., employee
severance) and these should be factored into the financial analysis

THE
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Tuck-In Acquisition Inputs

» Tuck-in acquisitions can be modeled with greater simplicity than full acquisitions
since their individual impact may not be that significant relative to the overall
acquisition program

» For simplicity, timing can be assumed to be at the beginning of each forecast
period

— This integrates working capital much more easily
« Several adjustments need to be considered to build in tuck-in acquisitions:
— Cost of each acquisition and assumed allocation to tangible and intangible assets
— Allocation of financing assumption to cash, debt and equity
— Measure the impacts on Revenue, COGS, EBITDA and CAPEX

— Consider proforma synergies at the acquisition level

THE
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Balance Sheet Impact

* Akey step is to adjust the balance sheet to reflect the fair market value of the acquired
assets and liabilities

— In preliminary analysis, this information is sometimes unavailable
» ltis also imperative to calculate the pro-forma capitalization of the new entity

« The impact on capitalization will dictate the optimal form of consideration, and the
maximum amount of leverage that can be used to consummate the transaction

» The steps to calculate the pro-forma balance sheet are as follows:

- Enter the most recent balance sheet values for each of the acquiror and target, side by side in the
spreadsheet

- Include an “adjustments” column to the right of the target’s balance sheet

— Sum the values from the Acquiror, Target and Adjustments columns to derive the pro-forma
balance sheet

THE
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Balance Sheet Impact (Cont'd)

« The following adjustments need to be made to calculate the pro-forma balance sheet:
1. Cash

— Combine the target and acquiror’s cash, and make adjustments to reflect cash proceeds from
options as well any target or acquiror cash that is assumed to be used to fund the acquisition

2. Other Assets

— Combine the target and acquiror’s other assets, and make an adjustment to reflect any
incremental goodwill and asset “write-ups”

3. Debt

- Combine the target and acquiror’s debt, and make adjustments to add any new debt being used
as consideration and subtract any target debt being refinanced

4. Other Liabilities

— Combine the target and acquiror’s other liabilities, and make an adjustment to reflect any new
deferred tax liabilities arising from asset “write-ups”

5. Common Equity

— Combine the target and acquiror’s equity, and make adjustments to subtract the target’s book
equity and add any new equity being used as consideration

THE
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Ratio Analysis

» In order to determine the impact of a potential acquisition, a number of ratios can be
calculated:

* Accretion / Dilution
- % change in EPS
- % change in CFPS
- Pre-tax synergies to break-even
« Credit Ratios
— Net Debt / Total Capital
- Net Debt / EBITDA
- EBITDA/ Interest
« Operating Ratios
- Gross Margin
- EBITDA Margin
- ROE

THE
!G\?{é&wEE 27 © 2006 The Marquee Group Inc.



Sensitivity Analysis

« Data tables are used in the summary section of a merger model to assess the impact of
changing one or more variables

» While the type of sensitivities used may vary depending on the type of transaction and
industry of the target and purchaser, the following are several commonly used
sensitivities:

— Purchase price or premium to market

- Method of financing (% equity / % debt)

— Cost of financing

- After-tax synergies

- Pro-forma multiples (to assess the potential pro-forma share price)

THE
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Accretion / Dilution Considerations




Accretion / Dilution “Rules”

« EPS accretion / dilution in a transaction is determined by the “value” of the target’s stock
per dollar of earnings (expressed as a P/E ratio) relative to the value of the acquisition
currency being used by the acquiror

* In an all-stock deal:

— If acquiror’s P/E > target’s P/E (at the transaction price), the deal will be accretive to the
acquiror’s earnings

- This is because the acquiror’s stock is more valuable (the market is paying more for a dollar of the acquiror’s
earnings compared to the target)

« Because debt is cheaper than equity, using more debt as consideration will always
make a transaction more accretive

* In an all-debt financed deal, the acquiror’s P/E is irrelevant
- The “value” of the acquiror’s currency in this case is the inverse of its after-tax cost of debt

- Therefore, if:
1/ [(Cost of Acquiror Debt) * (1 — Acquiror Tax Rate)] > Target P/E
then the deal will be accretive

» To determine the cost of debt in an all-cash deal where pro-forma EPS will break even,
simply set the two sides of the formula above equal, and solve for the cost of debt

THE
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Limits of Accretion / Dilution

« A common misconception is that accretion translates into value creation (i.e., an
increase in the acquiror’s stock price) and dilution results in value destruction

— This reasoning assumes that the buyer will retain its existing P/E multiple after the deal
» Since P/E multiples reflect the market’s perception of the quality and growth of earnings,

in reality the acquiror’s pro-forma P/E should reflect a blend of its pre-deal P/E and the
target’s P/E

- For example, if Company A has a P/E of 10x and acquires Company B which has a P/E of 15x,
an all-stock deal will be dilutive to Company A

- However, Company A’s pro-forma P/E should expand to reflect the addition of Company B’s
higher growth earnings

« Thus, accretion / dilution analysis should always be examined with a view as to the
acquiror’s potential pro-forma multiple

In theory, the determining factor in whether an acquiror’s stock price will rise or fall after an acquisition is the
market’s perception of the price paid compared to the intrinsic value of the target (including the present
value of the synergies to be achieved). If the acquiror pays less than the PV of the target and related
synergies, its share price will rise, and visa versa.
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Post-Transaction Analysis

» Post-transaction analysis can be used with accretion / dilution data to assess potential
outcomes for an acquiror’s stock price

— This will create a more meaningful analysis than simply examining
accretion / dilution on its own

» Using a P/E multiple methodology, a range of assumed P/E ratios can be applied to the
pro-forma EPS results from the model to impute the acquiror’s pro-forma stock price

— The “appropriate” post-deal P/E ratio will be a function of many factors, so choosing this metric is
more art than science

« Pro-forma EV/EBITDA ratios can also be used to calculate the implied acquiror stock
price

- The calculations are more involved in this case since adjustments (based on the acquiror’s pro-
forma capital structure) need to be made to enterprise value to arrive at equity value

THE
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Description of Excel Functions




Offset Function

« The OFFSET lookup function is also extremely useful at extracting information and can
be used to create summary tables

= OFFSET(Reference, Rows, Cols, Height, Width)

— OFFSET returns a cell or a range of cells that is a specified number of rows and columns from a
reference cell.

The OFFSET function has 3 mandatory arguments:

Reference: The reference cell (also known as the “anchor” cell) from which
the offset function is based

Rows: The number of rows, up or down, that you want to move from the
reference cell

Cols: The number of columns, to the left or right, that you want to
move from the reference cell

The OFFSET function has 2 optional arguments:

Height: The height, in number of rows, that you want the returned
reference to be

Width: The width, in number of columns, that you want the returned
reference to be
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Incorporating Pull Down Menus

» To create a more user-friendly interface on a scenario switch, a pull down menu can be
used to control the OFFSET function

« A pull down menu restricts the values that can be entered into the switch cell, thereby
reducing the possibility of causing an error

« Bring the Forms toolbar onto your screen by doing the following:

Excel 2010 & 2016: > File [F] » Options [T] > Select the “Customize Ribbon” box
» Put a check in “Developer” Tab box > Click Developer menu up top
» Click the “Insert” button

* Click on the “Combo Box (Form Control)” button and use the crosshair to draw a combo
box on your screen

« While the Combo Box is selected, right click and go to » Format > Control

- On the “Control” tab, select the range of cells containing the names of the various scenarios in the
“Input Range” box

— On the “Control” tab, enter the switch cell in the “Cell Link” box

» Click OK, then use your mouse to pull down the arrow and run the scenario

THE
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HLookup Function

» Lookup Functions are very useful for extracting information from large tables

= HLOOKUP(Lookup_value, Table_array, Row_index_num, Range_lookup)

- HLOOKUP (horizontal lookup) function searches for a value in the top row of the table, and then
returns a value x number of rows beneath the top row

The HLookup function has 4 arguments:

Lookup_value: This is the item you are searching for. This item must be found in
the first row of the table.

Table_array: The entire table in which you are searching for the data.

Row_index_num: When Excel finds the item you are searching for (the Lookup-

value) in the first row of the table (the Table_array), it will move a
certain number of rows down to extract the data that you are
looking to retrieve.

Range_lookup: To find a close match, type TRUE (or omit).
To find an exact match, type FALSE.
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Connecting Strings of Data

» Connecting strings of data is critically important when creating input or assumption
pages, row labels, or when adding footnotes to tables

e (Concatenate Function
= CONCATENATE(“text1”,A1,“text2”...)

Joins text strings and cell references into one text string

Especially useful for assumptions pages or footnotes to tables

This function does not extract formatting from a cell being referenced

Formatting needs to be done manually, or by using the TEXT function
- Manual: =CONCATENATE(“The tax rate used in the model is ”,E20*100,“%")
- TEXT Function: =CONCATENATE(“The dollar amount is ”, TEXT(E21,“$0.00"))
* Ampersand “&”
- The same functionality as the CONCATENATE function

— Connects or concatenates multiple text strings and/or cell references to produce one continuous
text string

- e.g. =“The tax rate used in the model is "&E20*100&“%"
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Sensitivity Analysis

« Goal Seek
Excel 2010 Excel 2016
» Data [A] »What-If Analysis [W] >Goal Seek [G] » Data [A] » What-If Analysis [W] > Goal Seek [G]

- Very simple sensitivity analysis, it back solves equations
— Finds a result for a cell by changing the value of another cell

— You instruct it to set a calculated cell (say A1), to a predetermined value (say 0.55), by changing
one other cell

« Data Tables
Excel 2010 Excel 2016
» Data [A] »What-If Analysis [W] »Data Table [T] » Data [A] » What-If Analysis [W] > Data Table [T]
- Creates multiple outputs under different input assumptions

- Link the cell in the top left hand corner of your table to the output value in your model that you
would like to sensitize, then highlight the entire table

- Select the “Data Table” option from the menu

- In the “Row Input Cell” box, enter the input cell in the model that you would like to sensitize along
the horizontal variable of your data table

— In the “Column Input Cell” box, enter the input cell in the model that you would like to sensitize
along the vertical variable of your data table
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Conditional Formatting

» This function formats cells that meet pre-specified criteria

- If you have more than one rule, the first rule will take priority over the second rule, so it’s
important to enter the rules in the appropriate order

— The first step is to highlight all data that you want the formatting applied to (when highlighting a
column, you must start at the top and highlight down)

Excel 2010 Excel 2016
» Home [H] » Conditional Formatting [L] » Home [H] > Conditional Formatting [L]

* There are two ways to conditionally format cells:

1. Built-In Formatting Rules — formats based on cells that contain certain text, numbers, or date or
time values

- For example, it is possible to “Format Cells that are GREATER THAN” 25, all values greater than 25 will be
formatted

2. Use a Formula — gives additional flexibility

- For example, enter the following formula =D2>average($D$2:$D$558), all values larger than the average will
be shaded within the range of D2:D558 (think of the = sign at the beginning of the formula as the word “if”)

— The rule that was created will be evaluated as TRUE or FALSE within each cell in the range
- If the rule is evaluated as TRUE, the selected formatting will be applied

- If the rule is evaluated as FALSE, the selected formatting will not be applied
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Creating a Dynamic Named Range

* Creating a pull down menu in Excel can be tedious because whenever new data is
added, the pull down menu needs to be updated manually

« To avoid manually updating the pull down menu, an Offset function can be used within a
Dynamic Named Range to automate the pull down
- In the “Pulldown” tab of the spreadsheet, column A contains reference numbers to show the total

number of entries (up to a total of 25) and column B contains specific company names (there are
no column headers)

- NOTE: In column B of the “Pulldown” tab, use a combination of an HLOOKUP function to transpose the
company names; an ISERROR function to return either the company name or a “0”; and a custom format to
show “ " if a “0” is returned

- We will need to create a Dynamic Named Range for the Company Names

To create a Dynamic Named Range, go to:

Excel 2010 Excel 2016

» Formulas [M] > Name Manager [N] » Formulas [M] > Name Manager [N]

— In the “Name” box, enter the word “Pulldown”

- In the “Refers To” box at the bottom, enter the following formula:
=OFFSET(Pulldown!$B$1,0,0,COUNTIF(Pulldown!$B$1:$B$25,"<>0"),1)

— While the Combo Box is selected, right click and go to » Format > Control

— On the “Control” tab, type in the “Pulldown” range name in the “Input Range” box
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For more information on:

The Marquee Group
Q TheMarqueeGroup.com
info@TheMarqueeGroup.com

o  +1416583 1802

Training The Street
Q TrainingTheStreet.com
info@TrainingTheStreet.com

o +1866931 5403 (Toll-free, US)

THE

MARQUEE

GROUP

A TRAINING THE STREET COMPANY


https://marqueegroup.ca/
https://trainingthestreet.com/
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